
TechGraf Help Index
Welcome to TechGraf, a tool for the production and analysis of 2D line and scatter plots.

How to:
Get Started
Format Objects
Receive Support
Register

Commands
File menu
Edit menu
Data menu
View menu
Format menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits TechGraf.



Edit menu commands

The Edit menu offers the following commands:

Cut Deletes data from the document and moves it to the 
clipboard.

Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another 

application.
Delete Erases selection.
Links List and edit links to embedded documents.
Insert TechType 
Label

Insert text object using TechType

Insert New Object Embed new OLE object



View menu commands

The View menu offers the following commands:

Zoom Change axes limits, selected graphically
Unzoom Restore axes limits after Zoom command
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

View Scale Changes the displayed scale

View Scale command (View menu)

This command opens the View Scale dialog box, allowing you to specify a scaling factor for the display.    
Note that this scale factor does not change the printed image, or the sizes of the objects in inches or 
centimeters.



View Scale dialog box

This dialog box, opened with the View Scale command, allows you to specify the displayed scale factor.    
This is a multiplicitive factor, rather than a percent, i.e. 1.0 is 100%, etc.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Log Window Displays the Log Window
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in TechGraf. 
You can open an existing document (.tgr file) with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the file extension you want to display.

Drives
Select the drive in which TechGraf stores the file that you want to open. 

Directories
Select the directory in which TechGraf stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    TechGraf suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, TechGraf displays the Save As dialog box and suggests that you name
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, TechGraf displays the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    TechGraf displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    TechGraf adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your TechGraf session.    You can also use the Close command on 
the application Control menu.    TechGraf prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Delete command (Edit menu)

Use this command to delete the current selection.    If more than one object is selected, 
TechGraf will prompt you to select one item.

Shortcuts
Keys: Del



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in TechGraf, such as File Open.    A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in TechGraf,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    TechGraf displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, TechGraf displays the Save As dialog box.

Opens a new data file.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Inserts a TechType text label via OLE.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the TechGraf window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

TechGraf displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using TechGraf and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
TechGraf.



Context Help command 

Use the Context Help command to obtain help on some portion of TechGraf.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the TechGraf window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the TechGraf window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    TechGraf determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    TechGraf determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the TechGraf window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

This dialog box allows you to change the font and color for the axis labels, or symbols on 
your plot.



Choose Color dialog box

This dialog box allows you to choose the color for your plot.    Only "solid colors" are used.



Getting Started

Upon first entering TechGraf, you will first want to open a data file using the Open Data File 
command.    After this command is executed, you will then format your plot.    TechGraf uses 
an object oriented formatting interface.    After formatting your plot, adding any additional 
plots to the page, etc., you can then save your work in a TechGraf file using the File | Save 
command.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that TechGraf is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.





Paste Link command (Edit menu)

Use this command to paste an OLE object, such as a sound file or bitmap picture, contained 
in an external file.    When the external file is modified,    the representation in your TechGraf 
will reflect those changes.

Before using this command, an OLE object must have been copied to the clipboard from an 
OLE server application (e.g. Paintbrush, Sound Recorder).



Links command (Edit menu)

Use this command to display a    Links dialog box which lets you edit links between your 
document and other documents.

This command is unavailable if you have no links in your document.



Links dialog box

The following options are available in the Links dialog box:
Links

Displays all links in a document. The four columns contain the application, filename, item
name, and type or status of link.

Update
Select the type of link you want for the selected links in the Links box:
Automatic Inserts new data as soon as it is available.
Manual Inserts new data only when you ask for it by choosing the Update Now button.

Locked
Prevents updates to a selected link. If you lock a link, the Update Now option is 
unavailable.

Open Source
Opens the source of a selected link -- for example, choosing the Open Source button 
opens up a linked chart in Microsoft Excel if you have a Microsoft Excel chart linked to 
your document.

Update Now
Updates all links selected in the Links box, and then closes the dialog box.

Cancel Link
Breaks links for all selected links between data and the document, and then closes the 
Links dialog box.

Change Link
Displays a dialog box so you can change the selected link to receive data from another 
application, file, or item. 



Object verb (Edit menu) 

Use this command to open the application in which the selected object was created and 
display the object so you can edit it.    This command is available only when you have 
selected an existing object in your document.    When you finish editing and close the 
application window, TechGraf incorporates the changes into your document.    This menu 
name changes depending on the object you select.

For example, if you select a Sound Recorder sound, you can select either Edit or Play from 
the Sound Object submenu.

Shortcut
Mouse: Double-click the object with the left mouse button.



Insert New Object command (Edit menu)

Use this command to insert an object from another application.    The application supplying 
the object will become active on your screen.

If a focus rectangle is defined, TechGraf will attempt to format the new object into the focus 
rectangle.

Select the object you want to insert into your document using the Insert New Object dialog 
box.



Insert New Object dialog box

Choose the Object command from the Insert menu to insert an object from another 
application.    Select the object you want to insert into your document from the Insert New 
Object dialog box.
Object Type

Some common objects are drawings, graphs, spreadsheets, and equations.



Technical Support 

The author can be contacted at the following address (e-mail preferred):

Ronald B. Jones
3715 Lexington Dr.
Hoffman Estates, IL    60195
USA

e-mail: ronjones@xnet.com 

I also monitor the Intelec BBS net Shareware and Windows conferences.

All questions and comments are welcome.    Priority will be given to registered users.



Registration Information 
Thank you for your interest in TechGraf.  TechGraf is distributed as 
shareware.  You may evaluate TechGraf for a period not to exceed 30 days.  
Following the evaluation period, if you wish to continue using TechGraf, you 
must register.  Upon registration, you will receive a key file which will 
eliminate the shareware reminder dialog box.

To register, first print out this registration form (using the File|Print 
Topic command in WinHelp).  Fill out the form and mail it with a check for 
US$30 to:

Ronald  B. Jones
3715 Lexington Dr.
Hoffman Estates, IL  60195
USA

If you have an Internet e-mail address and can accept your key file 
electronically, you may reduced your payment to $28.

Thank you for supporting TechGraf!

TechGraf Registration Form
Name:____________________________________________________________

Address:_________________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________

E-mail Address:__________________________________________________

Comments:________________________________________________________

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________



Format menu commands

The Format menu offers the following commands:

File Settings Choose which column to plot and assign axes to a data set.
Axes Change axis limits, axis type and other settings.
Object Format any object currently defined.
Defaults Set default options for axis length, font sizes, etc.
Center Page Centers all objects on page

Note that these commands are usually accessed by clicking with the right mouse button on 
the object that you wish to format.



File Settings Command (Format Menu)

This command will, after prompting for a data set if more then one is defined, open the File 
Settings dialog box.    This dialog box allows changing basic properties for a data set, such as
the axes to use and the columns to plot from the data set.



Format Axes Command (Format Menu)

After prompting for an axis to format, this command will open the Format Axes dialog box.    
This dialog box allows you to set the limits and type (log or linear) for an axis.
 



Format Object Command (Format Menu)

This command will present you with a list of all objects (Axes, data files, OLE objects) 
currently defined in your document.    Upon selecting an object, the applicable dialog box is 
called.



Format Defaults Command (Format Menu)

This command will open the TechGraf    Defaults dialog box, allowing various defaults to be 
set for newly created objects.    When the dialog box is closed, the selected defaults will be 
written in the techgraf.ini file in your Windows subdirectory.



Center Page Command (Format Menu)

This command centers the graph on the page, given the current page settings, indicated by 
the dashed line on the display.    If the page settings are updated using the Control Panel 
while Techgraf is running, run the Print Preview Command from the File menu to update the 
page setting. 



TechGraf Defaults dialog box

This dialog box allows various default    settings to be specified for newly created objects.    
When the OK button is selected, the settings are written to the file "techgraf.ini" in your 
Windows subdirectory.    The dialog contains the following fields:

X, Y Axis Length: The default length for X and Y axes, specified in inches (or cm).

Label Font Size:    The default label point size.

Label Font:    The default label face name.

Title Font Size:    The default point size for new axis titles.

Title Font:    The default face name for new axis titles.

Tick Direction:    Specifies whether ticks point "In" (towards the data) or "Out" (away) from 
the data by default.    This default can be overriden by the Angle field in the Format Ticks 
dialog box.

Label Spacing:    The default distance in inches (or cm) from the axis to the axis labels.

Symbol Font Size:    The default symbol size for scatter plots.

Symbol Font:    The default face name for scatter plot symbols.

Symbol Character:    The Ascii value of the default character to be used for scatter plots.

Title Spacing:    The default distance in inches (or cm) from the axis to the axis titles.

Origin Pos. (X,Y):    The origin for new plots in empty documents.

cm/Inch: Units for page posittion and length measurments.    When this choice is changed, 
all other fields in this dialog are converted to the new units.    Therefore it is best to make 
this choice first, before changing the other defaults.

Default Scale:    The initial viewing scale.    See the View Scale command.



Data menu Commands

The Data menu offers the following commands:

    
Open Data File Reads a data file and starts the File Settings dialog.
Reread Data Rereads all data files from disk.
Interpolate Interpolates on a data set.
Integrate Numerically integrates a data set.
Data Readout Displays the coordinates of the cursor relative to a data set
Fit Generate a least square fit of a data set
Write Data Writes a data set to a XY file
Smooth Generate a sliding average of the data
Error Bars Assign error bars to a plot

Zoom Command (View Menu)

This command will change the axes limits to match the boundaries defined by a focus 
rectangle.    This command is useful for taking a closer look at features in your data, and can 
be undone with the Unzoom command.



Unzoom Command (View Menu)

This command restores the affected axes to the limits existing before the last Zoom 
command.



Write Data Command (Data Menu)

This command allows data to be written to an external data file.    This command is usually 
used with fitted or smoothed data sets that are normally stored in your TechGraf (.tgr) file.    

See Also:

Fit submenu commands          Smooth



Smooth Data Command (Data Menu)

This command generates a sliding average of your data.    You are first prompted to choose 
which data set to smooth and then the Data Smooth dialog box is opened, allowing the size 
of the averaging window to be chosen.    The smoothed data is then plotted, without erasing 
the original plot.    The smoothed data is stored in your TechGraf (.tgr) file, and can then be 
written to disk with the Write Data command.

The smoothing is performed by replacing each data point with the average of the "N" data 
points surrounding it, where N is the window size specified in the Data Smooth dialog box.    
This procedure is a "quick and dirty" way of finding trends and features in noisy data.    There
are better ways, eg. low pass filtering in the fourier domain,    that can be found in a number 
of numerical analysis and scientific computing books, but this method is fast, simple, and 
requires few assumptions about your data.



Error Bar Command (Data menu)

This command will first prompt for a data set,, then opens the Error Bar dialog box, allowing 
a data column and file to be chosen for the error bar data.    Error bar data specifies the error
for each point,    Error bars are drawn to plus or minus the value in the error bar data.    Only 
Y errors are supported.



Error Bar Dialog Box 

This dialog box allows data to be selected for error bars.    If error bars are being created for 
the first time, the file is set to the same file as the regular data, and the column for the error 
data is set to the last column in the file.    The dialog box contains the following fields:

Data File Name:    The data file that we are choosing error data for

Error File Name:    The name of the file that the error data comes from.    Will usually be the
same as the Data File Name.

Error Bar Column:    The column that contains the error data.

Change Error File:    Launches a File Open dialog box allowing a new file to be chosen for 
the error data

Remove Error Bars:    Removes the error bars from the plot.



Data Smooth Dialog Box

This dialog box is called by the Smooth Data command.    The Window Size field allows you to
specify the number of points averaged at each position. in the data.    This number must be 
odd.    If an even number is specified, a warning is posted and the window size is reduced by 
one.



Fit Submenu Commands (Data Menu)

This command allows you to generate least squares fits to a variety of functions.    When any
of the submenu commands are selected, you are first prompted as to which data set to fit to.
A dialog box will then open allowing parameters to be set for the fit.    Several of the fields 
are the same for all of the functions:

Use X Data:    Uses the x values of the data for the plotted fit.    This is useful if the fit data 
is to be saved to disk using the Write Data command.

Even X values: Plots data points evenly spaced from the start X to the end X values.

Number of points:    Specifies the number of points to plot from the fit function if the "Even
X values" button is selected.

X start, X end:  Specifies the starting and ending X values for the fit and the fitted plot.    
These fields will be initialized with the left and right edges of    the focus rectangle if one is 
defined.

When OK is selected in the dialog box, the fit is performed and the coefficients are reported 
to the log window.    A new data set is created based on the fit functions and the parameters 
selected in the dialog box.    The data for this data set is stored in your TechGraf (.tgr) file, 
and can be saved to disk using the Write Data command.    Once the fit is performed, the 
fitted plot will not reflect any changes in the original data set,    If your data changes, the fit 
process must be redone.

See also:
Fit functions 



Fit functions

Polynomial:    Fit to the function c[0] + c[1] x + c[2] x2 + c[3] x3 + ...
The order of the fit is selected in the dialog box (1 for linear, 2 for quadratic, etc.).

Power:    Fit to the function a xn.      See note below.

Exponential:    Fit to the function a ebx.      See note below.

Gaussian:    Fit to the funcions a exp(-b2(x-xo)2).      See note below.

Note that the Power, Exponential, and Gaussian fits require taking the logarithm of    the 
data.    The data must therefore not be zero or negative.      If the data set contains negative 
data, you will be prompted to continue with absolute values.



Data Cursor Dialog Box

This modeless dialog displays the mouse position in your data coordinate system, along with
the position of the nearest point in the data set.    The dialog contains the following fields:

Data Set:  Combo box allows you to pick which data set will be used to determine the 
coordinate system used and the data points to represent in the "Cursor" and "Data" X and Y 
fields.

Close:    Button to close the dialog box.    The dialog will also close if a data set is deleted, or 
if the Close command is selected from the system menu.

Cursor:    X and Y position of the mouse cursor, in the coordinates defined by the data set 
selected in the Data Set combo box.

Data: X and Y position of the data point    that has the highest X value that is less than the 
cursor X position.    This data point is also marked on the plot.



Data Readout Command (Data Menu)

The Data Readout command allows you to read points from your data sets using the mouse 
cursor.    The command opens the Data Cursor dialog, which displays the mouse position in 
your data coordinate system, along with the position of the nearest point in the data set.



Focus Rectangle

A "focus rectangle" is a rectangular area on the screen defined by the user.    It is defined by  
holding down the left mouse button and dragging.    Any objects in the focus rectangle will be
selected.    These objects can then be dragged as a group around the screen.    There are 
several other uses for the focus rectangle:

If a focus rectangle is defined when the Open Data File command is selected, the new data 
set is plotted using new axes defined by the focus rectangle.

The Zoom command uses the focus rectangle to define new axis limits.

The Integrate and Fit commands use the focus rectangle to establish default start and end 
points for the analysis.

A new embedded object or pasted object is placed in the lower left corner of the focus 
rectangle.



Numerically integrating data

This command allows you to numerically integrate your data.    This command opens the 
Integrate Data dialog box.    If a focus rectangle is defined, the initial and final limits of the 
dialog box are initialized to the boundaries of the focus rectangle.



Log Window 

The Log Window reports the results of all interpolations, fits, and integrations.    The text in 
the Log Window can be copied to the clipboard using the Edit|Copy command, or saved to a 
text file using the File|Save As command. 



Interpolating values from a data set

This command allows you to interpolate and extrapolate points on your data sets.    This 
command opens the Interpolate Data dialog box.



A modeless dialog box can stay open while you perform other work in TechGraf. 



Integrate Data Dialog

This modeless dialog allows you to choose parameters and perform numerical integration on
your data.    The dialog contains the following fields:

Data to Integrate:    Combo box with list of all current data sets.    List updates itself when 
data sets are deleted.

Start X:    The lower limit for the integration.

End X:    The upper limit for the integration.

Integrate:    Button starts the trapezoidal rule integration.    The result is displayed in the 
"Integration" field (below the button) and is also reported to the Log Window

Close:    Closes the dialog box.



Interpolate Data Dialog

This modeless dialog allows you to choose parameters for interpolation and extrapolation.    
The dialog contains the following fields:

Data to Interpolate:    Combo box with list of all current data sets.    List updates itself 
when data sets are deleted.

X:    Enter the x value for the interpolation or extrapolation

Y:    Shows the result of the last interpolation.    

Interp:    Button performs the interpolation on the data set selected in the "Data to 
Interpolate" box at the position in the "X:" field.      The result of the interpolation is written to
the "Y:" field and also to the Log Window 

Order:    Enter the order of the interpolation, i.e. "1" for linear, "2" for quadratic, etc.

Close:    Closes the dialog box.



Rereading data

This command rereads all open data files from disk.    For example, if you have plotted the 
result of a numerical computation, you can rerun the computation using different 
parameters, select this command, thereby seeing the new results.



Opening a data file

This command prompts for a file name and attempts to read a data file.    If the file is read 
successfully, the File Settings dialog box is loaded.

If the data file has already been loaded for another data set, the copy of the data file in 
memory is reused.    This allows multiple data sets from a large data file to be plotted quickly.
If you change the data file using another program after it has been read by TechGraf, use the
Reread Data command to reread the file and update your plots.

Shortcut

Toolbar:



A data set consists of an X column and a Y column from a data file



Data File Format

TechGraf reads comma, space, or tab deliminated Ascii files.    Data may have up to 20 
columns and up to 4,294,967,295 rows, or as many as can fit in available memory.    Data are
represented internally as double precision floating point numbers.    Up to three lines of 
textual information (data headings or comments) at    any point in the file will be ignored.

See also:
TechGraf Files 



TechGraf (.tgr) Files

TechGraf (.tgr) files contain formatting information, OLE data, data from fitted or smoothed 
data sets, and pointers to data files.    TechGraf    files do NOT store your data, only the file 
name.    Your data is read fresh each time that the TechGraf file is opened, and your plots will
reflect any changes made in the data.    If you change your data with another program while 
a TechGraf file is loaded, the data may be reread with the Reread Data command.

TechGraf files store the complete path name of your data files, allowing data and TechGraf 
files to be stored in different directories.    If the data file is not found when the TechGraf file 
is opened, the directory that the TechGraf file is in is also searched.    This allows, e.g., 
copying TechGraf and data files to a floppy drive and read on another computer.

See also:
 Data Files 



Format Axes Dialog Box

This dialog allows you to set the properties for an axis.    Fields include:

Name:     Name of the axis.    Each axis must have a unique name.    The name can be 
changed to anything you wish, as long as it is not used by any other object in the document.

Position X, Y:    Position of the origin in inches from the lower left corner of the page.

Length:    Length of the axis in inches.

Start, End:    The start and end limits for the axis.    The minimum and maximum data 
values for the data sets associated with the axis are also shown.

Auto:    This checkbox will reset the Start and End fields to default values.    This control is 
disabled if there are no data sets associated with the axis.

Log:    Specifies that the axis is logarithmic.    This control is enabled only if the Start and End
limits are positive.

Title:    Creates an axis title if one does not already exist and opens the Format Axis Title 
dialog box.

Ticks and Labels:    Opens the Format Ticks dialog box for the axis.



Format Ticks Dialog Box

This dialog allows options to be set pertaining to ticks and data labels for an axis.    Fields 
include:

Ticks Spacing:    Spacing in data units between ticks.

Label Interval:    Number of tick intervals between label ticks, i.e.    a value of "1" means 
every tick is labelled,    "2" means every other tick is labelled, etc.

First Label:    The value of the first label.    This is useful if you do not want the start 
coordinate of the axis to correspond with the first ticks.

Tick Angle:    The angle of the ticks in degrees.    X axes default to 90, Y axses default to 0.

Minor, Major Tick Length:    Length of the major (labelled) and minor (unlabelled) ticks.    
The ticks can be made into grid lines by changing this value to equal the axis length.

Automatic Ticks:    Resets the above fields to reasonable default values.    If this value is 
set, the tick settings will reset if the axis settings change.    If this is not set, the tick settings 
must be changed manually.    If, for example, the addition of another data set changes the 
axis limits, the tick settings above will adjust if this setting is checked.

The following fields control the formatting for the labels:

Decimal/Exponential/Auto:    Specifies if decimal or expontential notation is used for data 
labels.    Auto uses the numerical value of the label to decide which to use.

Decimal Digits:    Specifies the number of decimal places to show in the labels.    If the 
"Auto" box is checked, a reasonable default will be used.

Label Offset:    The X and Y distance in inches from the axis to the label.

Fonts:    Opens the    Font dialog allowing the label font and color to be set.

Hide Labels:    Hides the labels.    Allows major ticks to be written without labels, usually for 
top and right side axes.



File Settings Dialog

The File Settings dialog allows fundamental paramaters to be set for a data set.. Fields 
include:

X Column Chooses the column for the x data.    Column '0' plots the 
numbers 1... N where N is the numbers of rows in the data.

Y Column Same for y data.    If more than one data set is desired for a 
data file, open the file again with the Open Data File 
command.

Description Specifies the name for the data set.    Each data set in a 
document must have a unique name.    If the name you 
choose is not unique, TechGraf will prompt you for a new 
name.

Origin Specifies the position for the origin of the plot.    If these data 
are changed, the positions for the associated x and y axes will
be changed accordingly.

Linetype Opens the Format Linetype dialog for this data set

Axes Prompts for an axis and opens the Format Axis dialog.

X,Y Axis controls The combo box allows a previously created axis to be chosen. 
The 'new' button creates a new axis for the x or y axis.    The 
'edit' button launches Format Axis dialog.



Inserting Text Objects

Text labels are supported in TechGraf through the TechType OLE server.    Selecting the Edit|
Insert TechType Label command will start TechType.    Input your label in TechType, and select
File|Update in TechType.    If a focus rectangle was defined when TechType was started,    your
label will appear in the focus rectangle.    Otherwise, the label will appear in the lower left 
corner of your    document.

If TechType fails to start, there may be a problem with your registration database.    First, try 
running TechType from the File|Run menu of Program or File Manager.    TechType will then 
attempt to re-register itself.    Exit TechGraf, then restart and try again.    If TechType still 
doesn't start, try using the regedit utility included with Windows 3.1

Shortcut

Toolbar:



Line Type Dialog Box

This dialog allows you to specify the appearance of the plot of the selected data set    Fields 
include:

Line/Symbol/Both:    Specifies if    a line, scatter, or combination plot is to be displayed.

Line Type:    Specifies whether the line is solid, dashed, etc.    This control is disabled if the 
Symbol button is selected, or if the "Thin" box is not checked..

Color:    Opens the Choose Color which allows you to specify the color of the line.

Width:    Specifies the width of the line in inches.    Placing a value in this field unchecks the 
"Thin" box and sets the Line Type to Solid.

Thin:    Check box sets the width of the line to one pixel, regardless of the device (display or 
printer)

Font/Size:    Displays the currently selected font for your plot symbols.    Techgraf uses 
TrueType fonts for plot symbols, with 10 point Wingdings as the default.    There are several 
characters in this font that are very suitable for plotting symbols.

Font...:    Opens the Choose Font dialog box allowing the font, size and color of the plot 
symbols to be selected.    This button is disabled if the "Line" button is selected.

Character:    Combo box (under the Font button) allowing the character for the plot symbols
to be selected.



Formatting Your Plots

TechGraf uses an object oriented, right-mouse-button-gets-a-menu interface.    What this 
means is that when you right-click on an object in your plot, a menu or dialog box is called 
allowing formatting options to be set.

Currently, there are four    object types defined:
Axes
Axis Titles
Plots
OLE Objects

In addition to these on demand menus, some objects can be moved and sized directly via 
the mouse.    

Objects are selected in two ways.    Individual objects can be selected by left-clicking on the 
object.    Multiple objects can be selected by drawing a focus rectanglearound them.    
Selected objects can be copied to the clipboard using the Copy or Cut commands, deleted 
with the delete key or the Delete command, or moved by dragging with the mouse.      Axes 
and OLE objects can be sized by clicking and dragging the sizing handles that appear when 
the object is selected. 



Axes

Axes define the x and y coordinates for your plots.    When your first data file is opened, 
creating your first plot for the document, x and y axes are created.    Additional axes can be 
created in several ways.    When a focus rectangle is defined and the Open Data File 
command is selected, new axes are created with lengths and positions matching the left an 
bottom sides of the focus rectangle.    Additional axes can also be created in the File Settings 
dialog box.    Finally, axes can be created by using the Mirror X Axis or Mirror Y Axis 
commands from the Plot menu.

Right clicking on an axis will bring up the following menu:

Settings... Opens the Format Axis dialog box.
Ticks... Opens the Format Ticks dialog box
Font... Opens the Choose Font dialog box, allowing the font for the axis 

labels to be set.
Title... Creates or modifies an Axis Title for the axis.    Opens the Format Axis

Title dialog box for the title.

When axes are selected, they may be moved or sized with the mouse.    To move, simply 
click and drag inside the focus rectangle.    To size, click and drag the sizing handles.



Axis Titles

An axis title is a simple title added to an axis.    The axis title is always centered on the 
associated axis, with the distance from the axis being adjustable.    When the axis is moved, 
the axis label is moved along with it.    An axis title is created by right clicking on the axis 
and selecting the "Title" command, or by clicking on the "Title" button in the Format Axis 
dialog box.    An axis title can only contain a single font, and does not support subscripts or 
superscripts.    If you require more complex    formatting, you can use a TrueType object or 
other OLE object.

The text of the title, the distance from the axis and the font can be set    by right clicking on 
the title and opening the Format Axis Title dialog box.



Format Axis Title Dialog Box

This dialog box allows formatting of an axis title.    It includes the following fields: 

Text:    The text of the title.

Font:    Opens the Choose Font dialog box, allowing the font, font size and color of the title to
be set.

Distance from Axis:    Specifies how far below (for X axes) or to the left (for Y axes) of the 
axis the title is placed.



Plots

 A plot is the visual representation of a data set.    Plots can be created by the Open Data File
command, by the Smooth command and by the various fit commands.    Plots always have 
an X and Y axis associated with the plot, which forms the data coordinates for the plot.    
Plots can not be moved or sized directly with the mouse.    To move a plot with the mouse, 
select the axes and move them.    You can select the plot and all axes by drawing a focus 
rectangle around all the objects.

Right clicking on a plot will bring up the following menu:

Data Settings Opens the File Settings dialog box 
Line Type Opens the Line Type dialog box
Color Opens the Choose Color dialog box for setting the color of the line
Symbol Font Opens the Choose Font dialog box allowing the font, size and color of

the plot symbols to be set
Mirror X, Y Axis Copies the X or Y axis to the other side of the plot, rotating the ticks 

by 180 degrees, and hiding the labels on the copy.    Used to quickly 
create "top" and "right" side axes for a finished appearance

Error Bars Opens the    Error Bar dialog box 

OLE Objects

OLE objects are inported from other programs, such as TechType or Paintbrush.    OLE objects
are created by the Insert Object command, or the Paste Link command.    TechType OLE 
objects can also be created with the Insert TechType Label command.    Once created, the 
server application can be launched by double clicking on the object.    OLE objects can be 
moved or sized with the mouse.    Right clicking on an OLE Object will open the Format OLE 
Object dialog box.    TechGraf currently supports OLE 1.0 only, with OLE 2.0 support in a 
future version.



Format OLE Object Dialog Box

This dialog allows the appearence of OLE objects to be    altered.    It contains the following 
fields:

Position:    The X and Y coordiates (in inches) of the lower left corner of the object.    Note 
that the object can be also be moved by dragging with the mouse.

Angle:    Rotates the object.    Note that changing this from zero will cause the object to not 
print properly on some printers.    The text angle for TechType labels should be set by the 
Format Angle command in TechType, rather than here.

Scale:    The X and Y scaled value, in percent.    Note that this feature also does not work 
properly on all printers.      Scaling can also be done by selecting the object, and dragging 
one of the sizing handles.



The units used for page postiions, axis length etc. can be changed from inches to cm with 
the Format Defaults command. 




